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Installing BoostSpeed 13

Auslogics BoostSpeed 13 X

English (United States) Grreeeeceeecccceeaas N

Select the interface language from the

]

drop-down list at the top-right.

Welcome to BoostSpeed 13

Launch the installer by double-clicking

Next generation of PC maintenance Review and check or uncheck

on the downloaded file. additional options.

Installation directory:

Click the links to review the EULA ' C:\Program Files (x86)\Auslogics\BoostSpeed

and Privacy Policy.

v Create a desktop icon

v Launch program at Windows startup (D)

Click the ‘Agree and install’ button to

start installation v Send anonymous info to help improve our service O

4
@@ ®®®®®®® @@ w®




Make sure the checkbox to launch Auslogics BoostSpeed 13
BoostSpeed is checked and click the
‘Finish’ button to complete installation.

Installation complete

v Launch BoostSpeed

O B @@ @D @@ D D @ D @ D @ @ D @ @ @ D - D - - - - - - oo
@

...................................................................
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Free vs Pro

Essential PC cleanup & optimization

Advanced PC cleanup & optimization

Manual Internet optimization

Automatic Internet optimization for an ultimate connection speed boost
Basic privacy protection

Advanced privacy protection for all data stored on your PC
Browser Anti-Tracker to protect your online privacy

Menu Manager

Add-ons Manager

Basic registry cleanup

Full registry cleanup

Basic junk cleanup to free up disk space

Advanced disk cleanup options to maximize available space

Disk defragmentation to speed up data access

Intelligent Defrag to optimize file placement on drives for an even bigger speed boost

Scheduled disk defragmentation to maintain drive health

Scheduler for effortless regular scans and maintenance

Ask a Question option for live expert answers at a click of a button (1 question in free version)

Unlimited use of all advanced PC tools

Customize notification settings

FREE

PRO

BoostSpeed comes in two versions: Free and
Pro. The Free version offers basic functionality
for cleaning your PC and improving its
performance. The Pro version provides a
multitude of advanced features that let you
take full control of your PC’s functioning. This
table should give you an idea of what you can
expect from each version.

When using the Free version, you will see all
Pro features marked with the yellow [13{®) tag.
This should give you a good idea of what you
can get if you upgrade. The rest of this manual
will talk about both Free and Pro version
features in more detail.

Purchase BoostSpeed Pro



https://www.auslogics.com/go/userguide/en/software/boost-speed/purchase?m=bs13manual

(® To Contents

Registering BoostSpeed Pro

To unlock and use all of the Pro features, you need to upgrade your BoostSpeed Free to the Pro version. Here is how to do that:

%5 NET: 6,3 Kbps RAM: 84% a

(?) Auslogics BoostSpeed

Register Auslogics BoostSpeed

Enter your license key:
If you received the license key by e-mail, we recommend copying and pasting it to avoid

G25KW-75HK7-XHPQW-9HIXJ-FTESC @ I RE¢

 Get alicense key JHow to Upgrade from Previous Versions | How to Register

Registered version lets you:

>

G Instantly fix all

H«) Keep your PC running fast
performance issues ¢

and smooth

~ Unlock over 15 powerful
tools

@ Extend your PC's service life

* Trustpilot £ >

'oo4nnﬁ‘é:

---------------------------------------------------------------------

S
Ceccrcccene®e® .,
)

.
0
0
L]
.......

@ D@D DD DD WD DD WD D WD WD D W WD D WD WD D W W D WD D D D D D D Dy
L)

Click the ‘Activate Pro Version’ button at the bottom-right of the program window. This will bring
up a small window with a field to enter your key in.

If you've already purchased a license and received a license key via email, copy your key from the
confirmation email. Then, go back to BoostSpeed, paste the key into the registration field and
click ‘Register.

Don't have a license yet? Click the ‘Get a license key’ link below the registration field to go to a
web page where you can purchase a license.

NOTE

When you place your order online and complete payment, a confirmation message is sent to
you via email to the address you provide during checkout. You will be getting two messages: one
containing your invoice and the other with your license information. If you don't see the
message(s), please check your spam/junk mail folder before contacting technical support. A
common reason for not receiving an order confirmation is typos made in the email address, so
be sure to double-check your contact info when placing order.
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Backing up with the Rescue Center

Auslogics BoostSpeed is equipped with the Rescue Center, which lets you create a backup prior to running optimization or any other operations. This helps ensure that you can

always roll back any changes made by Auslogics tools if you do not like the results.

We recommend getting familiar with the
Rescue Center prior to using BoostSpeed for
the first time. You can specify which parts of
the BoostSpeed package should back up
before each run, how long those backups
should be stored and how much disk space
they may occupy.

RAM: 63%

..........

To access the Rescue Center settings,
click on the gear icon at the bottom-
right of the program window.

In the Settings window that opens, scroll
down to the bottom of the left-side
navigation pane and click on ‘Rescue Center.,
This will open the current Rescue Center
settings and let you change any of them

according to your preferences. If youd like, you

can have most tools create backups as you

first start using BoostSpeed and then uncheck

them as you get more comfortable with the
program.

IR

(]

(]

(]

(]

;
V

® RESCUE CENTER

Rescue Center

Select which tools should use the Rescue Center to create a backup prior to making changes. This will allow the changes to be undon:
if necessary.

Auslogics Programs

El My Scanner

E] Maintain

{j Protect

@ Internet Optimizer
{’5} Tweak Manager

D Task Manager

) Duplicate File Finder
@ Uninstall Manager

FI] Startup Manager
@] Registry Cleaner
Disk Explorer

F1) Windows Slimmer

Delete backups older than:

Max. disk space for backups (%):

Backups folder: | C:\ProgramData\Auslogics\BoostSpeed\13.x\Rescue

Backup | Recycle Bin

®
®
®

& Cancel




.....

- - » - - oo ®

@ Recovery Rescue Center

....‘....
Source

Undo changes made to your computer by Auslogics programs.
Select a restore point from the list below and click Restore.

To view backups created in the Rescue You can also view available system

Gommmmmmcmmeens

© Create # Restore ; X Delete | 4 Refresh

Center, click on the diskette icon at the =1 kg | restore points here by selecting ‘Restore
- cription

bottom-right of the main program B —- Points’ from the left-side menu. Use this

© Restore Points

window. feature if you need to take your whole

system back to a point in time before
In the window that opens you will you applied specific changes or installed
see a list of available backups that certain software, not just Auslogics.
have been created by BoostSpeed.
Select a backup from the list and |
then choose the action you would :
like to apply to it by clicking a button
above the list, such as ‘Restore,

‘Details’ or ‘Delete’ Clicking ‘Refresh’

[¢] Also show restore points older than 5 days (if available)

will refresh the list of available
backups. Click ‘OK’ when done.

@ nNOTE

When you use a restore point, under certain circumstances, you may lose all changes made and all files saved after the date to which you are rolling back.
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Where to Start?

When you launch BoostSpeed for the first time, you will have no
doubt as to what to do first. Just click the big button in the middle
of the screen to run your first scan.

File View Tools Help ® Auslogics BoostSpeed 13 & — X

@:} My Dashboard E My Scanner ]m Clean Up %'.: Optimize O Protect |:I Maintain ,Q Ask a Question T? AlTe '

Last scan performed: 29.08.2022 ' Advanced mode 4:"0-".
To the right of the Scan button, you see the gear icon taking you to : e i

the ‘Customize scan’ option where you can choose sections to
scan or ignore, if needed. Clicking it is optional. : : Wotld yoi like o anablé sutormtic

maintenance?

Activate Automatic Maintenance

To the top-right of the Scan button you see the mode switch that
lets you easily switch to Advanced mode, if you feel that you want
more control and more options at hand. By default, BoostSpeed
launches in Basic mode for the first time. You can also switch

modes by going to the View menu at the top-left. See more Ay S s -
. . . . . - check your disk space for cleanup potentia - locate potential privacy vulnerabilities B Speed ly its
information on the two modes further in this guide. AN i Rt e e
« pinpoint stability and performance glitches « review your Internet connection settings Go to My Advisor
« check your system drive for fragmentation « check for recommended Windows tweaks
Here you will also find 6 of the most useful tools listed below the 3oyl
o flc ; NEW — NEW | VTN s l
Scan button. Clicking the three dots at the top-right of each tool : L5 \) | O () ] ’
c 547 = N My Tools

tile will bring up options to remove the tile or replace it with s R Sh

Enable Manager Manager Manager Manager

another tool. (More information about these tools is provided

Ta NET: 30,0 Kbps RAM:

further in this guide)

My Stare My Questions

On the right, see the quick links to more recommended features

that will help improve your PC even further.
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Top Menu

The main program menu is located at the very top of the program window and gives you four drop-down lists of shortcuts to almost every BoostSpeed feature.

Run application...

Help ® Auslogics Bc

@ Online Manual

Tools Help

>< Close this tool

System Tools Tweak Manager

Disk Tools Visit Website

Windows Control Panel Startup Manager

Internet & Browser Tools Visit Program Page

@ Switch to Dark Mode

Security Tools Service Manager

Run My Scanner Download Free Auslogics Apps

: @ Switch to Basic Mode

Info Tools Uninstall Manager

Automatic Maintenance Technical Support

Default view

@ Auslogics Driver Updater Registry Cleaner

Rescue Center... Send Feedback

(@ Auslogics Anti-Malware Registry Defrag

, Send Debug Log

{3
©
S
(@
=7
86
e
(@)

Settings... :
@:ﬁ Auslogics Disk Defrag Ultimate Windows Slimmer
Check for updates o Register Program
Auslogics BitReplica Add-ons Manager
The View menu lets you switch __ GI_A 9 P _ © Request Refund
' Sy
Close between Basic and Advanced modes, % Menu Manager -

switch interface skins or set
BoostSpeed’s interface to its default

appearance.

--n‘o--‘ ---c'c--- ‘--n‘o--‘
The File menu contains the main options that let you quickly run any program or The Tools menu gives you quick access to all tools included in The Help menu lists the options you
open a website by simply typing its name or address in a popup window, open the BoostSpeed, as well as some additional Auslogics software that you have for getting information about the
Control Panel, run a scan, schedule maintenance, open the Rescue Center, may install. program or assistance with it.

settings or check for updates.
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Program Modes: Basic Mode

BoostSpeed comes with two modes that are meant to accommodate users of any IT experience level.

File View Tools Help © Auslogics BoostSpeed 13

E Scanning (71%) E‘ My Advisor [ﬁl Clean Up Tf All Tools O Protect

Advanced mode "‘

13505

Scanning,
please wait...

15/19 Adult Website Traces
Internet Explorer

[§ See scan details

Cat Mode Add-ons is ¢ Multi Uninstall Startup Menu
Enable Manager ¢ Manager Manager Manager

3 CPU: 42%

...................................................................................................

The Basic mode minimizes the amount of thought or effort required of the user to run
maintenance: the screen has a big button in the center with just the essential tabs and
tools along the window edges. All you need to do is click the Scan button to launch a

comprehensive checkup of your Windows system.

D Maintain

s —

-
,Q\ Ask a Question 52 Op "

Would you like to enable automatic
maintenance?

Activate Automatic Maintenance

Select recommended actions and let
BoostSpeed apply its power

Go to My Advisar

T}

My Tools

My Questions

& HDD: 37% o e B ©

© Auslogics BoostSpeed 13 € — X

My Advisor E Clean Up 'é'.: Optimize O Protect D Maintain R Ask a Question Tf Al P

[¥] ALL AREAS (SUMMARY) Scanning Internet Speed... - 0 Internet items found
(—

—p E Internet items found

@ DISK SPACE n categories processed .|
() staBILITY
(¥) PERFORMANCE

(¥) DISK DEFRAG

() PRIVACY

S

INTERNET SPEED

@ WINDOWS 10/11 TWEAKS

Current category: Internet (1 of 1)
B4% @ pause |i| stop

Analyzing tweak: Global Max TCP Window Size

S5 NET: 24,7 Kbps RAM: 84% " Activate Pro Version

.........................................

While the scan is running, you can stop or pause it, see the progress right below the
button or click on ‘See scan details’ to see the categories and specific items being
processed along with the number of actionable items found.



File View Tools Help

B My Scanner

® Auslogics BoostSpeed 13 & —

‘m Clean Up

Y1 AnTools

O Protect D Maintain

E‘ My Advisor ,Q\ Ask a Question % Optim

Advanced mode C,“

Would you like to enable automatic
maintenance?

Activate Automatic Maintenance

Resolve

Select recommended actions and let
BDDstSpEEd apply its power

8 535 items found. 1,12 GB of junk files can be deleted.
Go to My Advisor

Click the button to resolve all items or click on 'See full report’ to review scan results

[ See full report

N

T

R

L

Cat Mode : Multi Uninstall Startup Menu

Enable Manager efra § Manager Manager Manager My Store My Questions

Fa NET: 2,6 Kbps RAM: 70%

When the scan completes, you can just click the Resolve All button on the
Dashboard, or click on ‘See full report’ to switch to the My Scanner tab.

Help ® Auslogics BoostSpeed 13

O Protect D Maintain

= My Advisor Iﬁ] Clean Up g Optimize

Disk Space - 616,75 MB of junk files found
files can be deleted to free up 616,75 MB of disk space
[#] Include Disk Space in the repair

(¥) Disk SPACE

Stability - nothing found

All is good, no action required under this category.

(+) PERFORMANCE

@ DISK DEFRAG Performance - 112 items found

(+) PRIVACY

items can be optimized to speed up your PC

[#Include Performance in the repair

2 Ask a Question

C - X

U7 Antoots [ uninstat i *

See report and customize

See report and customize

Disk Defrag - 684,97 MB fragmented files found

- files can be defragmented to speed up data access

[#] Include Disk Defrag in the repair

{3 CPU: 14%

Rescan All Resolve Selected

See report and customize

& HDD: 0%

On the My Scanner tab, review all detected items under each of the seven

categories, and decide if you want the cleanup to ignore any of them. You can click

on the category names on the left to switch between them, click the ‘See report

and customize’ link next to each category for a more detailed view, and uncheck

any of the detected items or subcategories, if you like. When done reviewing, click

the ‘Resolve Selected’ button at the bottom to launch repair.
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Tabs in Basic Mode

In Basic mode, you see the most essential tabs at the top.

—

1 My Dashboard =:'~\ My Advisor ,Q\ Ask a Question WT All Tools

N N\ N
O @ .
My Advisor, where you can see recommendations for Ask a Question, where you can get expert answers to your  All Tools, where you can see a full list of all tools included
what needs to be done at the moment. PC-related questions, as well as find other ways to get in BoostSpeed split into categories, so you can easily find

help. the tool you need.
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Bottom panel

Below the main window is a collection of the most useful tools for everyday tasks.

Cat Mode

This handy tool locks your PC’s keyboard
and mouse when you step away, so that
your pet can't do damage to your system
or data. When you return, you will need to
enter a pass code to unlock your PC. You
can set the pass code and activation delay
in mode settings.

......................

Add-ons Manager

The tool lets you sort through and disable
browser and application add-ons, and shell
extensions. Clicking on this tile will open Add-
ons Manager in a new tab and display a list of
all installed add-ons. You can review each add-
on's trust rating, info about the maker and
other details. Click the toggle in front of each
add-on’s name to turn it on or off.

You can remove or replace tools as you like to create a custom toolkit you'll always have at hand. To

do that, click the three dots at the top-right of any tool tile.

Add-ons
Enable Manager

Disk Defrag

Winner of multiple industry awards, Auslogics
Disk Defrag is an essential tool that lets you
defragment hard drives, optimize SSDs and
offers a number of other features to help
ensure top data access speed.

Multi Uninstall Startup Menu
Manager Manager Manager

Multi Uninstall Manager

The tool lets you go through all software
installed on your PC, select unneeded
programs and uninstall them all in one click
instead of manually going through them one
by one. Multi Uninstall Manager will queue the
apps for removal and safely remove them one
at a time.

Menu Manager

This tool lets you customize the context
menu (the right-click menu) for many
Windows elements, including files, folders,
drives, the Recycle Bin, etc. You can review
the menu’s current appearance, then

choose to add or remove options as you
like.

......................

Startup Manager

This tool handles the common cause of slow
PC bootup. It lets you review the apps set to
run on Windows startup, and cut the list down
to the bare minimum, which can effectively
speed up system loading. The tool opens in a
new tab.
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Right-Side Panel

The right-side panel in Basic mode provides easy access to BoostSpeed sections recommended as a must for anyone

My PC

This is your quick link to detailed information about your system,
including hardware specs, OS and major software. Click it whenever
you need the specs, such as when talking to tech support or looking

to upgrade hardware parts.

My Store

The link to the Auslogics Store lets you access more useful software

from Auslogics and its partners, review information on each program é"\
and download installers. Full versions of the recommended programs
may require license purchase.

My Questions

This link takes you to the Ask a Question tab, which will be described

further in this guide.

Would you like to enable automatic
maintenance?

Activate Automatic Maintenance

b |
@

N

Select recommended actions and let
BoostSpeed apply its power

Go to My Advisor

>

A iy Ul
’

# " a

My Tools

AP | [l
o o
. A j’h LN

My Store My Questions

Grrnnnens .

Here you can Activate Automatic Maintenance so you can forget
about it and let BoostSpeed monitor your system and take action.

My Advisor takes you to a tab that houses recommended actions you
may want to take to improve your PC’s state. This tool is especially
useful to those who like to find new ways to boost their computers,
as it will give you ideas on what to do next every time you open
BoostSpeed.

My Tools

This link takes you to the All Tools tab where you can find the full list
of all tools included in BoostSpeed. Click it whenever you need to
quickly find and open a specific tool.
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Program Modes: Advanced Mode

To the upper-right of the main Scan Fle  View  Tools  Help @ Auslogics BoostSpeed 13
button In BaS|C mOde, you Wlll .I:Ind : 'F:J My Dashboard G My Scanner E‘ My Advisor Tj’ All Tools ,Q\ Ask a Question %
the switch that will take you to -
Advanced mode. Another way to get @ o

O Your system: OS License:
there is by going to View -> Switchto | Windows© Heensed
Advanced Mode in the main program =

=) DISK SPACE

menu No data, scan recommended

@ STABILITY My Scheduler My Advisor

Review and run recommended

Set up automatic system .
i 4 actions here

maintenarice here

No data, scan recommended

©) PERFORMANCE

No data, scan recommended

After reviewing all the information

presented on this screen, you can ‘

E Options & Settings My Tools
move on to the full system scan nght ' ¢ Customize Scan . Customize BoostSpeed to fit your All BoostSpeed tools at a glance
) : J needs here here
from here by clicking the ‘Start a ‘ |
System Scan’ button (this will open :
the My Scanner tab and let you VP! _ LD o
choose the categories to check before et T e Mecacn e

launching the scan).

3 CPU: 23%

You have Pro!

Taking advantage of all these great
features and maore:

@ Advanced cleanup and tune-up
@ Tougher privacy protection

@ Unlimited use of 20+ tools

Get expert answers

Question(s) left,

Visit Auslogics Store »
Even more benefits for your

U PC with recommended

&2 HDD: 0%

When in Advanced mode, you get a
lot more options listed on your
Dashboard.

Get brief info about your PC and
software at the top with a link to
detailed system information.

See a quick overview of your
questions and answers status, or click
to access the Ask a Question feature
(described further in this guide).

Some of the options here are the
same as in Basic mode (see detailed
information earlier in this guide).



In Advanced Mode, you can
customize the tabs that you see at the
top by adding or removing them as
you like. To add tabs, click on the
sign and select the pages or tools you
want added from the drop-down list.

------------------------------------------------------------------------------------------

© Auslogics BoostSpeed 13

Q  Ask a Question| X Tf All Tools m
__ ages
: System Tools
Disk Tools
Internet & Browser Tools
Security Tools

Info Tools

———— 1

Z AN
L\;—'_L\_‘—

| : K.

nswers here

resents a new unique feature: a way for you
pur computer experts.

pstions regarding Windows, PC, installed /
ask our experts and receive a comprehensive R

category:

Latest Questions
Windows questions Q

®
@
=
m|
©
]
2

My Dashboard
My Scanner
My Advisor
Clean Up
Optimize
Protect
Maintain

Ask a Question
Reports

All Tools

- - - - oo oo o®

°
®-
°

To remove a tab, simply click the X sign
on it, just like you would in a web
browser. This way you can set up the
Dashboard just the way you want with
the tools you'll use most often.
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BoostSpeed Tabs

Let’s look at the Pages that can be set as tabs. Pages are screens that have multiple tools and options listed on them by categories, so you can have all related tools at hand when
you need to accomplish a specific task

: B e .
0 (] ]
[ ' [
My Dashboard Vv : :
: File View Tools Help ® Auslogics BoostSpeed 13 - X !
Comes in 2 versions: Basic and ; _ : : -
‘. - .> " . ? All Tools ﬁ Add-ons Manager * -+ 0 :
Advanced, as described earlier in this * ' :
. - 16 ‘ L -
guide.
My Advisor
Clean up web browsers Th| n | ns r mmen | N f r
My Scanner ‘ PEEETE unm_zeded cache and activity traces from web browsers to clear space for more S tab Co ta S eco e dat o S O
This is the tab you switch to when RS e actions that you may want to take right
you need to customize the scan oy i sl Windi . now to improve your PC's performance,
] eratior Clean up system drive Clean up now "
Categorles and I"eV|eW scan reSUltS. : - . 1o el : ;J:‘_:rlf.;:ljggi;krii:aner to find and delete unneeded system items and other junk from Speed and SeCUFIty. SeleCt What YOU
NV OU e e L s e Vg : : want to do on the left, then look through
‘ """""""""" ‘ '_l' BEEIXTY unneeded files deleted. See full report

repair from here by clicking the Scan the recommended actions and tweaks in

All or Resolve All button at the Sort theough lerge fles the main part of the window.

FECRES Click the button next to any

Use Disk Explorer to find the biggest space hogs and move or delete them to clear

bottom of the page. (See more =l

information on the My Scanner tab recommendation you decide to proceed

earller |n th|S gUIde) Remove unused programs - : Wlth

Use Uninstall Manager to get rid of applications you no longer use.

O CPU: 1% B HDD: 0%
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Ask a Question

On this tab you can ask online experts your questions related to using Auslogics software or to getting your PC fixed and optimized.

To use the feature, you need to get
registered by providing your email
address and a display name. To do
that, click on the ‘Sign up’ button. In
the window that pops up, enter your
name or a nickname youd like to be
identified by on forum pages, then
your email address, and hit the
‘Register’ button.

Once you click the ‘Register button,
go to your Inbox at the address you
specified in the form and look for a
confirmation message with your
automatically generated password.
You will need to use that password to
log in when you go to ask your
question. Return to BoostSpeed and
click the ‘Sign in’ button to continue.

File View Tools Help

E My Scanner

® Auslogics BoostSpeed 13

@ My Dashboard E' My Advisor "‘[_,I’ | All Tools ﬁ Add-ons Manager X

@ All features related to program technical support

Ask a Question

Get professional answers here

Ausllugics proudly presents a new unique feature: a way for you

to directly contact our computer experts.

If you have any questions regarding Windows, PC, installed
software or devices, ask our experts and receive a comprehensive |
answer,

Hello, guest! Choose a question category:

[E) free questions left Windows questions

Sign in or sign up to continue  *
Software questions

Device gquestions

Sign Up T e
Having problems with Auslogics software?
Raset password Ask your guestion as many times as you need: it's always free.

Service terms [

Need help? () How to register (@) How to uninstall

See these useful links: (O How to upgrade from previous version @ View user manual

8

| b,

I

.:.' Ask a Question X [EE

Latest Questions £ Read other questions

09.09.2022 The JBL connected with Bluetooth Properly
where in the sound output of windows 10 it does not
appear

Hello

| conntected with Bluetooth the device - Speaker JBL Flip 5
(bluetooth connection only). It appear in the the Setting /
bluetooth Devices of Windows 10

But in the settin... Read Now

> disk defrag
hi, | would like some help as disk defrag after
defragmentation sometimes shows me the screen as an
attachment instead of contiguous lines; | have a windows11
pro 64 bit pc and dis... Read Now

S5 NET: 29,9 Kbps RAM: 53%

Once logged in, click on a category
name for your question, which will
open a form that will let you fill in
your question details.

To access the forum, click the ‘My
account’ button or use the link that
was emailed to you with your
password.

On the right, find the latest questions
posted by users through the Ask a
Question tool. Clicking on the ‘Read
now’ link will take you to the
question on the Auslogics forum,
where you can read the answers and
browse other questions.

In the lower part of this screen, you
see links to the most common help
topics.
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Submitting Your Question

This form opens once you select a category for your question under the Ask a Question tab.

I:_?] Ask a Question - New Question

e Creating...

Category:
Subcategory: Battery Issues
| Battery Issues
Message subject: - .
‘ Bluetooth Connectivity Issues
Write your question... | BSOD and Drivers Issues
Select the subcategory for your question topic, type in a descriptive | eorting e
subject and write your question in the big blank field. You can also use | Default Application Issues
the ‘Add file’ option to add screenshots or other files to provide more  : \DVD and CD playback Issues

L] . - L] L & y ° I 1
information on the issue you are having. When done, click the ‘Send’ Eles and Folders iiues

c - c 'H Network Is
button. Your question will be reviewed and posted on the web forum, i bl

and you will be able to log in and view answers to your question there

Add file:

Data sent will also include information about your system to help
[ ] assess the situation. By checking the box you confirm that you have Send Cancel
read and agreed to the Terms of Service.
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All Tools

The All Tools tab lists all of the apps that

are included in BoostSpeed, dividing them Q~

into performance categories:

System tools let you run maintenance
and optimization on your Windows
system.

Disk tools provide multiple ways to clean
your PC, defragment and maintain your
disk drives.

Internet and Browser tools help improve
connection speed and get online content
to load faster.

Security tools help protect your personal
information and secure your PC from
threats.

Info tools allow you to get and review
information about your system and
different aspects of its operation.

File View l Tools ' Help

@ My Dashboard E M_\;f Scanner E‘ My Advisor |§ i‘j’”_I All Tools 1_:] Add-ons Manager

System Tools - These toals help you take care of your system

{03 O S

Tweak Startup Service Uninstall
Manager Manager Manager Manager

Manager

Disk Tools - Helping keep your disk drives in good shape

(©
Disk Dis Duplicate File File
Defrag Dactor Finder Recavery Cleaner

Internet & Browser Tools - Helping you access web-based content at the fastest speed possible

,Q Ask a Question * +

i /
E\A
iR

Windows Add-ons
Slimmer Manager

Empty Folder
Cleaner i Defrag Ultimate

Auslagics Disk

{3 CPU: 5% B HDD: 0%

>

OO EE®E®E®E®®®®E®®®®®® @@

To find out what a tool does or how it
works, hover your mouse over it to bring
up a hint. Click on a tool to launch it, and it
will open as a new tab in BoostSpeed.

You can also access the tools listed here
through the Tools menu at the top of the
main program window.

You have seen many of these tools
recommended under other relevant tabs
throughout the program, but they are all
listed here in one place to make it
convenient for you to find the tool you
need when you are looking to complete a
specific job.
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Most popular tools

Out of the 20+ tools in BoostSpeed, the following are user favorites

Disk Startup
Defrag ® Manager ®

Uninstall File Add-ons
Manager © Recovery Manager ®

i

Menu Windows

5 el >

Registry Duplicate File Deep Disk
Cleaner ©® Finder ©® Cleaner ©®

Manager © Slimmer ©
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Disk Defrag

This is the Auslogics Disk Defrag that has been loved by users worldwide for over 14 years

You may also click the arrow on the Defrag button and select the operation you want to run: just In the center, you see the cluster map which you can use to get information about the location of
Analyze the drives to see the fragmentation percentage, run a regular defrag, optimize your SSD files and file pieces on your drives. When defragmentation is running, you can watch the clusters
drive using a special SSD-safe algorithm, run the Defrag & Optimize feature to help prevent being moved and files being put together on this map.
fragmentation, or run a quick defrag without analyzing the drives. ol
& 5
The defragmenter in BoostSpeed is one of File View Tools Help ® Auslogics BoostSpeed 13 & — X

the fastest on the market, with exclusive

@ My Dashboard E My Scanner E‘ My Advisor Tf All Tools ﬁ Add-ons Manager X ,Q Ask a Question X \@ Disk Defrag X

Hlocoooooooooee®

algorithms that are safe for your drives.
Drive Name ' Fragmented Size Free Space File System SSD  Scheduled D... Status

When you click on Disk Defrag under All {2 Options & Settings ~ [¥] & Windows () Lo R 2 - Ready

- : : } cecesesscsassassnsnsseseseens Data (D) ] 34133 GB 80,29 GB NTFS v - Ready
Tools, it will open in a new tab and display ¢ > E8 :

Vaoo®o@®®o®®®®®o®®®®®®®®®®®®®® @@ @@ ® - o ®

the list of all drives in your computer é v
system. : (Qh  List of Disks
E 08 Optimize SSD g L¢) []After completing:
' — e h ;
Check the boxes next to the drives youd : e Sl o8
like to scan and defragment. Clicking the : : Defrag
Defrag button will first run a scan of the ®---- Optimize SSD (use of special algorithm)
selected drives, then defragment them, if . \:| Disk Doctor | Defrag & Optimize (slower, use once a week) <_ _
defragmentation is needed. . Qui;k Defrag.(wi-thf:)ut analyzigg) |

F Free ®| Not fragmented '® MFT |® Unmovable Processing ® Fragmented ™ Defragmented
5  Registry Defrag

.General Files (D) | Volume info SMAR.T. SSD Support

Model: ST1000LM035-1RK172 Temperature: |
) é . Refresh details
Q Health: Bad (1) 27 °C



.- ®®®®®®®®®®®®®®®®®®®® g
-

o®

Free B/ Not fragmented ®/ MFT M| Unmovable

General ‘Files (D) :Volume infa, S\M.A.RT. |SSD Support

Model: ST1000LM035-1RK172

0 Health: Bad (!)

A

Attribute Name Worst  Threshold

SATA Downshift Error Count 100
| End-to-End error ‘ 92

Reported Uncorrectable Errors

Command Timeout

High Fly Writes

O CPU: 22%

Below the cluster map you can review detailed information on the selected drive,
including information on files, the drive’s S.M.A.R.T. status and other details.

This is where you can get alerted to hard drive problems and prevent data loss that may
occur due to drive failure.

Processing ™ Fragmented M Defragmented

Temperature:

ZF 0

Refresh details

Raw Data Status

0 @ OK: Always Passes
8 € prefail
0 K: Always Passes
o OK: Always Passes
O OK: Always Passes

8 HDD: 24%
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Startup Manager

This tool lets you review the applications set to run on system bootup and disable any that don’t necessarily need to be on the Startup list. This can significantly speed up
Windows loading.

When you click on Startup Manager a3 wyamisor [ antoos IMONSSIEREEEEEER <5 Optimize x 7] System information > . Click the ‘Google it’ link above the list
under All Tools, it will open as a new |+ Add = Properties (D Disable Dangerous & Refresn || {5 Google It B Qpooeosesscsceccesncccccsnsneceaces. SN ® to search the web for information on
- e k
. . Display N Rati Launch ... Publishe Locati :
tab and display a list of all = B e e - T pration the selected startup item.
~ Startup Folder
app[ications that have been added to @ © Deepl auto-start Not rated Startup Folder\Current ...
_ ~ UWP\Run .
the Startup I-ISt- » - Cortana @ Trustwo.., Microsoft Corporation UWP\Current User . YOU can seleCt an app and see Its
‘) HyperX NGENUITY @ Trustwo... HP Inc. UWP\Current User :-_' trUSt rating, publisher name and

] . . : D Intel ® Graphics Com... @ Trustwo... INTEL CORP UWP\Current User 2 :
To disable an app, just click the : @ iTunes @ Trustwo.. Apple Inc. UWP\Current User some other details below.

l . f f h y |L'; iTunes ® Trustwo.. Apple inc. UWP\Current User
togg e In front of the apps name. L " Sl Phone Link ) Trustwo.. Microsoft Corporation UWP\Current User

4 @ Trustwo... Adobe Systems Incorporat... Registry\All Users\Run
@ © AquaSnap daemon ® Trustwo.. Nurgo Software Registry\Current User\R...
@D & CarambaSwitcher.exe @ Trustwo... Registry\Current User\R...
» u EpicGamesLauncher @ Trustwo... Registny\Current User\R...
& @ ESET command lineg i... @ Trustwo... ESET Registny\All Users\Run
[ @] @ rences Settings Danger... Stardock Corporation Registry\Current User\R...
@ B Figma Agent ) Trustwo.. Registry\Current User\R...
@ ¥ iCloud Services @ Trustwo... Apple Inc. Registry\Current User\R...

. Cortana Status: Disabled ¢

Publisher: Microsoft Corporation File Exists: @ yes

Startup Type; When current user logs on Rating: @ Trustworthy
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Uninstall Manager

Wlth thIS tOOl, you can reV|eW all Software |nsta|.|.ed on your Computer’ Select the 4 lcanner %Z Optimize @ Clean Up E‘ My Advisor O Protect D Maintain ,Q Ask a Question ‘ﬁ’ All Tools '_'6 Uninstall Manager X
y ] ] . . eSS i ' erties = e
apps youd like uninstalled and remove them one at a time or in batches. ! G & urinst J= roeries s G coogln
0 E Options & Settings « | Size Last Used Rating
. : Microsoft Pay 4,9 MB 07.12.2019 17:41:59 ) Trustworthy
Using the tool is quite intuitive — just check the boxes next to the apps you want ‘ ! Microsoft People 265 MB 05.07.2021 0:09:30 % Trustuworthy
) ) ) : ’ . . ). . > L] 0:‘ 'ﬁ Aoplications 543 Microsoft Photos 1884 MB 06.08.2022 18:40:43 Trustworthy
removed and click Umnsta[L or Mu[t|p[e uninstall’ if removing several apps. : ) s Microsoft Solitaire Collection 63,6 MB 19.09.2022 10:06:11 © Trustworthy
. Seccspes eesssseses .>.g A Microsoft Sticky Notes 38,9 MB 04.08.2022 10:19:13 @ Trustworthy |
- ; Microsoft Store 56,3 MB 26.09.202 : @ Trustworthy
A Wisdows Fostires 148 Microsoft Tips 21,3 MB 2.07.2022 9:49: @ Trustworthy
= - - | Microsoft Update Health Tools 1,0 MB Not rated
B | 20 | Microsoft Visual C++ 2005 Redistributa... 69 M8 Not rated
T Microsoft Visual C++ 2005 Redistributa.. 4,9 MB Mot rated
I T 4 Microsoft Visual C++ 2008 Redistributa... Not rated

Microsoft Visual C++ 2008 Redistributa.. 13,2 MB Naot rated

Microsoft Visual C++ 2008 Redistributa.. 10,2 MB Not rated
T Microsoft Visual C++ 2010 Redistributa.. 18,2 MB Not rated
Microsoft Visual C++ 2010 Redistributa.. 11,1 MB Mot rated
Microsoft Visual C++ 2012 Redistributa.. 20,5 MB Mot rated
Microsoft Visual C++ 2012 Redistributa... 17,4 MB Not rated
Microsoft Visual C++ 2012 x86 Minimu... Not rated
Microsoft Visual C++ 2013 Redistributa.. 20,6 MB Not rated
Microsoft Visual C++ 2013 Redistributa.. 17,2 MB Not rated
Microsoft Visual C++ 2015-2019 Redistr... 20,1 MB Mot rated

DEDJDD_EQQD

W |

minln
h T T

Microsoft Sticky Notes Installed on:  (Unknown)

Publisher: Microsoft Carporation Program size; 38,9 MB

Help file | Technical support | Check far updates Rating: @Trustworthy

8 NET: 2,6 Mbps RAM: 58% || ¥
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File Recovery

This powerful undelete tool lets you bring back files you may have deleted by accident, or files that disappeared in a virus attack. It uses a smart algorithm to scan your drives for
previously deleted data and get the files you need restored

TO run a SearCh, set the Search locat|on(5) 4 My Scanner —;0.: Optimize Im Clean Up E’ My Advisor O Protect D Maintain ,Q\ Ask a Question ﬁ’ All Tools .\D File Recovery X - w Recover Selected u Scan Again

and criteria first (go through 4 steps in + 4] Disk Drives
{; Options & Settings ~ g Windows (C)
~- Data (D) Auslogics File Recovery
~ [¢] Other
& Recycle Bin Recover accidentally deleted files and documents from your computer disks,
USB memory sticks or digital camera memory cards.

setting the filters).

Microsoft-Shiel... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Wind... OK
Microsoft-Hype... OK
Microsoft-Wind... OK
Microsoft-One... OK
Microsoft-Wind... OK
Microsoft-One... OK
Microsoft-Wind... OK

When done with the search setup, click : 9 Free Space Wips

the Search button to look through the @®--. ™ File Shredde
“free” space on your drive(s). :

Look for the following file types:

(®) Search all files

Note that the sooner you act after O Search for these files only:
discovering the file loss, the better your
chances of getting all the data you need
recovered. Your deleted files are only
recoverable until they get overwritten with

new data.

When the search completes, you can look
through the results, preview certain file

'----------------------------'

......................

types (like pictures or documents) and

select the specific files youd like restored. ~ @---

L]
[
L]
L]
L]

Use the filter at the top to narrow down
the results, check the files you want and

’------‘

click ‘Recover Selected’ above the list. “ecsccccscccccscsccsccscsccsccscsscscssssscsssssssc s s s s s s sssssssssssssssssssssscssssssssssssssscsssssssssssssssssssssss?

D@ @D DD DD D - - oo oo
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Add-ons Manager

This tool lets you review information on installed browser extensions, plugins and add-ons, application add-ons and shell extensions. Identify unneeded ones and turn them off

with just a click.

Select an add-on to view information
about it below the list.

Click the toggle in front of the add-
on name to enable or disable it.

-’-------.'

4

L P PR EY LR T )

canner '%E Optimize m Clean Up E' My Advisor

F

{2 Options & Settings ~ Name

+ @ Chrome \ Toolbars
@ [ AdBlock — best ad blocker
I PW Adake Acrahat PDE adit e
[ @) E Chrome Web Store Payments
Shell Exte _;__._“ Color Picker
: &) B EditThisCookie
CE PR aO . Fair AdBlocker
@O . Kaspersky Protection
o . Malwarebytes Browser Guard

@] Browsers

._---__-----___---.)

Momentum

&
n Save to Google Drive
|
a

m Trello External Window
ge \ Toolbars

Kaspersky Protection

E Chrome Web Store Payments

Version: 1.0.0.6

s-----------------.)

Publisher: n/a

O Protect

¥ Delete = Properties (') Disable Dangerous

a Mate Translate — translator, dic...
Nimbus Screenshot & Screen ...

Tag Assistant Legacy (by Googl...
Touch VPN - Secure and unlim...

1? | All Tools

l:‘ Maintain ,.Q\ Ask a Question

7 Refrest. & Google It

Description

4

Block ads and pop-ups on YouTube, Facebook, Twitch, and your favorite websites.
Na mare in Gannala Chrame with Adake Arrnhat POE tanle View fill rammeant cian a
Chrome Web Store Payments

Calor Picker - grab colors from web pages, color picker, color history. Better than Color...
EditThisCookie is a cookie manager. You can add, delete, edit, search, protect and bloc...
Block annoying ads, popups, malware and tracking {even on Facebook & Youtube), bro...
Your protection on the Internet with extension from Kaspersky

The fastest and safest web browsing experience.

Your all-in-one translator for web pages, highlighted text, & Netflix subtitles, Translate ...

Replace new tab page with a personal dashboard to help you get focused, stay organiz...

Record screencasts - record video from your screen. Screen Capture FULL Web page or...
Save web content or screen capture directly to Google Drive,

Tag Assistant helps to troubleshoot installation of various Google tags including Googl...

Unblack any website and stay secure with Touch VPN. One-click cannect to our fast VP...

External Frameless Window for Trelle

Your protection on the Internet with extension from Kaspersky

Status: @

E Add-ons Manager X

14,3 MB

16 MR
909 8 KB

S522K8 |

2,6 MB

2,9 MB

B742 KB

22,8 MB

4,8 MB

158 MB

37,6 MB

3.2 MB

3.0 MB

54 MB

12,3 KB

8508 KB

Enabled

File Exists: (&) Yes

Rating:

o3 NET: 29,1 Kbps  [§] RAM: 54%

Mot rated

If an add-on’s rating is unknown or
you aren't sure if it's needed, use the

‘.-'

0 ‘Google it’ link above the list to
" search the web for information about
the selected add-on.
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Menu Manager

This newly enhanced tool is meant to help you customize your Windows experience by adding convenient shortcuts to right-click menus throughout the system.

1 canner = imize ean visor rotec aintain O  Ask a Question i oaols —ll Mlenu Manager X
With Menu Manager, you can add or ysome E opmue [ Genvp B wysvior Q) potet [ waman R akscumon 7 w0 [N
: 8= Prog (1) Disable Dangeraus (s Refresh ? Hover yOUI’ mouse Ccursor over the @
remove options from the context _ _ _ i :
{Z Options & Settings ~ Display Name i Ll _. b l t . th f h
menu (rlght_cllck menU) for Ob]ECtS {0 ) A right click on a drive opens this menu . Sym otto preVIeW € menu Tor eac
-\ SDriveMenu 3 ; wei\PCMa ; 1
like files, folders, drives, the Recycle LU ) - -...... i1 | = o object type.
: : B0 Commands tﬁwg) UltralSO - 311 GB free of Open in new window
BI n, etC. : ) : 5 i 20 _— Pin to Quick access
: - - : @ . FileSyncEx % Turn on BitLocker
: . : = —I,, stem = @ KK Kaspersky Anti-Virus 213 Ea Scan with Microsoft Defender... I\Kaspersk
CI.ICk the toggle N front Of eaCh . : M @D ¥F. Kaspersky Anti-Virus 21.3 Give access to )\Kaspersk
' P! Context Menu Tweaks i
i i I I a «© \ialS0 Restore previous versions J\Ultral SO\
option to add it to the right-click ®-- @ - Uiaiso o 1o St b
it : @ 2 winraAR S RAR\rarext
menu or remove It. B3 Uninstoll Manages -
Q. FileSyncEx SRy, p\AppDate
&} Service Manager a HwShareMenu Create shortcut wei\PCMa
[ @) ¥ Kaspersky Anti-Virus 21.3 Rename \Kaspersk

REYEHY e @ (=] open with LanguageTool (Lang.. () Propedtias b\AppDate
o ﬂ WinRAR (v) s RAR\rarext

* m Commands associated with Desktop and

a . FileSvncEx () Trustworthv  Microsoft OneDrive Microsoft Corporation  ChUsers\CurrentUser\AopData\F
L ____________________________________________________________________________________________________________________J

s Manage the menu that comes up when you right-click on a file, folder or shortcut. You can review, add or
= remove options, making the menu better fit your needs.

& NET: 27,9 Kbps RAM: 63%
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Windows Slimmer

If you are running a heavy Windows version on your computer, like Windows 10 or 11, then Windows Slimmer is the tool you may want to use before others. It lets you get rid of
the “filler” the operating system comes with, as well as the unneeded system-related items that may accumulate over time.

ol 2 imize ean visor rotec aintain sk a Question oals e Windows Slimmer X
The tool deletes demo content, old e | ot [l Sesnte || 58 Wy ) s | L e | e aston, T s | Choose a category (select one
WinSxS libraries, disabled Windows One-Time Maintenance : .
N 'ﬁ} PRSI | © :: Outdated WinSxs libraries R T Bl <----® cleanup category at a time for best
I ’ | can run operations after global °

compeneneiiIEse ce il AN syt charges . results) and click on ‘Start Scan’.
update files, old system restore : ©

[} o | 1L | Iall | e
points, etc. : ) s e et o

. FRWAC CiaanUR: ©) @ Old Windows version st scan: 04.10.2022 Show details €
When you ClICk On WIndOWS Sllmmer : E his ill compact Windows files O @ Windows Update files Last scan: 04.10.2022 Show details @
under All Tools, the tool will open o !  fedite the sodt of 44k Seacs

H H H ° 4 O 853 i t scar: nf Show details

with the One-Time Maintenance tab O {07 Windows demo content cart how details @

active by default.

® @ System restore points t scar: 1y Show details €9

O E Redundant Windows application folders Last scan: n/a Show details €

Select the section you'd like to check and click the 'Start Scan' button, You may select just one <_ e
section to ensure more accurate results.

%3 NET: 1,8 Mbps RAM: 38%
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scanner

%.: Optimize Im Clean Up

i
D)

&

?

¢

One-Time Maintenance

Using options in this section, you
can run operations after global
system changes.

Regular Maintenance

This tool contains options that can

be used to run regular cleanup.

Compact OS

This tool will compact Win

After the scan completes, you will be
E' My Advisor O Protect D Maintain ,Q.\ Ask a Question Tf All Tools ')‘,Ef Windows Slimmer X able to review the results and take action

as needed. BoostSpeed will not delete

@ Windows Update files 5,21 MB / 2 items anything without you clicking the ‘Start
Cleanup’ button.

You can select categories to clean up here 5,21 MB / 2 items selected

C:\Windows\SoftwareDistribution\Download\SharedFileCache\11b9a533894bc9d9f83ce7045a76c34df8.. 3,82 MB
CA\Windows\SoftwareDistribution\Download\SharedFileCache\56d589ca91bec2231f95ad877 1aec532df.. 1,39 MB

Attention! After you clean up this section, certain files may have to be re-downloaded from the Microsoft server.

Click the 'Start Cleanup’ button to launch cleanup ¥ Back to Rescan Start Cleanup <' °°°°°°°°°°°°°°°°°°°°°°

wl

) CPU: 3% 8 HDD: 0%



When done with the One-Time

MaintananCaR [ Regular ¢ Scanner '?0.: Optimize ]_lnl_l CleanUp [ My Advisor O Protect D Maintain ,Q Ask a Question Tf All Tools ",_'r‘-_l;i‘“ Windows Slimmer X

Maintenance in the left-side menu and One-Time Maintenance

choose the sections that may be cleaned Using options in this section, you CS Memory Dumps Last scan: 04.10.2022 Show details €@

can run operations after glo

up on a regular basis.

system changes.

@ CD/DVD Burning Cache Folder Last scan: 04.10.2022 Show details €@

i
Regular Maintenance
Y

This tool contains options that can

be used to run regular cleanup. 'm]' Recycle Bin Last scan: 04.10.2022 Shew details Q

You can have Windows Slimmer scan CorBact 08
JI 1 ; o L W L

and clean up memory dumps, CD/DVD _;%_ Fhis ool will compact Windows files Temporary Folders Last scan: 04.10.2022 Show details €3
burning cache, the Recycle Bin, e

temporary folders and application logs. E‘ Apslictionlogs (Bt e DN BETED Show details @

Just check the categories and click on
‘Start Scan.

Select the sections you want and click the 'Start Scan' button to launch a scan.

3 CPU: 14% 8 HDD: 2%

[}
JRIIPIRRIORRRPIRRIR R, 8~
[ ]




The third feature in Windows Slimmer's
left-side menu is ‘Compact OS’ The tool
lets you pack up system files to reduce
the amount of space they take up on
your drive. The feature is especially
useful when your OS is installed on a
smaller SSD drive which tends to run
out of space.

4

scanner %"Z Optimize ]m Clean Up

E' My Advisor O Protect D Maintain ,Q\ Ask a Question ﬁ? All Tools "H" Windows Slimmer X

{q—né} Using options in this section, you
can run o tions after global

One-Time Maintenance

Regular Maintenance

@ This tool contains options that can

be used to run regular cleanup.

Compact OS
% This tool will compact Windows files

to reduce the amount of disk space

the OS takes up on your PC.

Compact OS FEEEE

Auslogics Windows Slimmer can compact your Windows 10/11 OS and make
room for a few more gigabytes on your system drive. You may return your OS
to its uncompacted state by stopping this operation here.

" Please note that this feature is only used on Windows 10/11. We
recommend using it when your system disk space is minimal.

Th_e Compact OS featu‘re can ciear. 1to4 glgabyte§ of space on your system ERabIe CompaLi O
drive. To start compacting your Windows, please click the button. |

7N

(]
]
(]
L

If your system drive has plenty of space available, we recommend having the Compact

OS feature disabled to help your system access those files faster.
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Registry Cleaner

Auslogics Registry Cleaner is one of the safest tools of this type available today. Instead of trying to locate as many problematic entries as possible, the tool finds the items that
can be tweaked or removed with no risk of damage to the system.

Open the tool from under the All Tools tab, select the 5 File View  Tools  Help ® Auslogics BoostSpeed 13 B — X
entry types You’d llke to scan (Or keep the defaUlt ‘?'-es\ ¢ /Scanner T;'.: Optimize m] Clean Up E My Advisor O Protect I:l Maintain ’C_)\ Ask a Question Ti’ All Tools E(r_i Registry Cleaner X

sections checked) and click on ‘Scan Now’
v [v] e Shortcuts

{2  Options & Settings ¥ Start Mk Auslogics Registry Cleaner
Quick Launch

Recert DG ERTS Registry Cleaner allows you to remove orphaned keys and values that may carry

some risk of unexpected issues with your PC's performance. Click Scan to check the
Desktop Shortcuts registry for items to clean out now.

- Files

B Find Reqistry Keve File Associations 3
: ; . . Results to review
File Extensions

Help Files
History Lists

l!—m Clean Registry

[}

L}

(]

(]

(]

0

0

L}

(]

(]

(]

(]

0

[}

(]

(]

(]

0

0

L}

(]

(]

(]

: Last scan: 04.10.2022 at 19:34
L}

: - & Software Items cleaned out: 0 out of 441
(] 2 o

s Gl e Application Events Advice: scan is recommended
: Installed Software

(]
: (=) Saah Dick Clearer Application Paths

. ! Startup

. 10 Empty Folder Cleaner Missing Software

(]
' COM & ActiveX

(]
' M System

g Fonts

: [ Firewall

0
' Internet

(]
. [] Shared DLLs

: [] Virtual Devices

[}
0 [] Notification Area

(]
. [] Explorer Window Size/Position Cac... |

0

L}

()

(]

(]

(]

0

L}

[}

L )

[] Removed Folder Traces

g HDD: 0%



File View Tools Help ® Auslogics BoostSpeed 13 e — X

When the scan Completes, you Wil.l 4/ Scanner ‘%—E Optimize m Clean Up E‘ My Advisor O Protect D Maintain ,Q\ Ask a Question t? All Tools Cle Uncheck any items you don’t Want
see a list of categories with the - CEEEC R RTESPTTRTETITES 3 | resul 5 select~ G soogle it & Scan Again removed (if there are such items) and
] ] ' {E Options & Settings ~ = " Category
number of issues found in each. : B bleAsete click on ‘Resolve.
[+ File Extensions ¢ [v] File Extensians g
= ~ [v] & Software : [#] Installed Software
. mll Clean Registry [ isallad Eshware : 7 Missing Software
You may click on the category name T PR o hiekg v [¥] CoM & ActiveX
. ’ 5 i ol R Kaiex [¥] Unused Devices
to see more details on what's been =~ ®--., - & 8 sysem
. . . : : [#] Unused Devices
detected in it. Y B g
] : [ Nisk Cl
b8 D tmoyrodercieoner

CXEENENERENENENERENENENER]L EN RS

i Resclve [w] Back Up Changes
1 '3

= NET: 81,6 Kbps [ RAM: 64%

]
~---------------------------------------------..
]

......................................................
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Duplicate File Finder

This is another tool that can help free up gigabytes of disk space. File duplicates can accumulate over time, so cleaning them out should be part of the maintenance routine.

File View Tools Help ® Auslogics BoostSpeed 13 = — X

Open Duplicate File Finder by going .
to All Tools -> Disk Tools.

nner %O.z Optimize [m Clean Up E' My Advisor O Protect [] Maintain ,O\ Ask a Question Q{r All Tools |'_'t| Duplicate File Finder X

« [¢] Disk Drives
= WeNhs & s » [v] 2. Windows (C)

,--------------------> » ¥ - Data(D) Find Duplicate Files
Select the drives you want to search, .

o This program will find duplicate files on your computer, so that you will be able
— ! to delete the copies you don't need and free up some disk space.

- - - oo

the duplicate types and set other

Select which types of duplicate files should be searched:

.
search criteria by clicking ‘Next’ togo

through the available options.

(O Look for all file types

(@) Look for these file types only

[v] Video files

__|:| [v] Archives

[& @ Applications

When done, click the Search button.

P> - - - oo



When the search completes, you will see a list of all detected file duplicates divided into groups (each group highlighted with color).

You can look through the duplicates and check the copies you want deleted one by one.

O Protect

¢ nner %: Optimize\/ﬁl Clean Up E' My Advisor

D Maintain ,Q\ Ask a Question

¥ All Duplicates I© search Again 5] View Report

{Z Options & Settings ~ » £. Windows (C) Name Path
o . » . Data(D) 1_.03.swf  D:\Gam...
1_03.swf DAGam...
— 2 _02.swf D:AGam...
B sk Bplors 2.02swf  Di\Gam..
M Eile Shradder 2_04.swf D:\Gam...

2_04.swf
2_05.swf
2_05.swf
2_06.swf
2_06.swf
2_07.swf
2_07.swf
2_08.swf
2_08.swf
2_09.swf
2 _09.swf
2_11.swf
2_11.swf
2_12.swf
2_12.swf
2_13.swf

Ooo000000000o0boO0OoOoOoOooon

90 duplicates found (257,18 MB, Time spent 20 sec). You can now select and delete
one or more duplicates in the groups, leaving at least one (main) file in each group.

D:A\Gam...
DAGam...
DA\Gam...
D:\Gam...
D:\Gam...
D:\Gam...
D:AGam...
DAGam...
D:AGam...
DAGam...
DAGam...
D:AGam...
D:\Gam...
D:\Gam...
D:\Gam...
DAGam...

Size

4,26 MB
4,26 MB
1,66 MB
1,66 MB
1,17 MB
1,17 MB
1,92 MB
1,92 MB
2,14 MB
2,14 MB
2,23 MB
2,23 MB
2,04 MB
2,04 MB
1,66 MB
1,66 MB
1,10 MB
1,10 MB
1,06 MB
1,06 MB
1,25 MB

ad Files

VT Al Tools

Last Modified

09.07.2022 12:14:33
09.07.2022 12:14:38
09.07.2022 12:14:38
09.07.2022 12:13:07
09.07.2022 12:14:39
09.07.2022 12:13:07
09.07.2022 12:13:07
09.07.2022 12:14:38
09.07.2022 12:14:40
09.07.2022 12:13:08
09.07.2022 12:14:40
09.07.2022 12:13:08
09.07.2022 12:13:08
09.07.2022 12:14:40
09.07.2022 12:13:07
09.07.2022 12:14:40
09.07.2022 12:14:39
09.07.2022 12:13:07
09.07.2022 12:14:39
09.07.2022 12:13:07
09.07.2022 12:14:39

Select :I v‘ : ;
el (| )

O

O CPU: 15%

7N

8 HDD: 0%

@ Duplicate File Finder X

However, the easier alternative is to click

Filter M on ‘Options & Settings’ in the left-side

Preview ¥

menu and choose an option that will let
you select duplicates in batches.

'~ All Duplicates

Options & Settings « » 2. Windows (C)

Invert Selection

Select Duplicates by Modification Date >

Select One in Each Group
Select All Duplicates in Each Group

Select all duplicates of these *.swf files

No pre = Add Mask to the Ignore List
review

Or you can click the arrow on the
i ‘Select’ button below the list and
choose an option from the drop-
down menu that appears.

Details

Header
When done selecting, click the

‘Delete Selected Files’ button below

the list, or click the arrow on this

c .0

button and choose how you want
the duplicates deleted.

s
~---------------:.-----------------
(]
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Advanced Mode Tabs

When you are in Advanced mode, you see more tabs available at the top of your BoostSpeed window. Those extra tabs, displayed in Advanced mode only, include:

LY
S

Fila

@ Auslogics BoostSpeed 13 (L S File

Q) protect  [0] maintain

Toals Help

timize TS

niner C

3 My Advisar

O sk s uestion [ uplicate File Finer 4 nner

Optimize

Wiea Toals Help
25 Optimize O = vy ndvisor () protect

Windows 10,
wersion 13044

Wind,

Registry Cleanup

tries and maintain

Deep Disk Cleaner

Defragment selected d to prevent See detalls &
explarer.exe
Integrator.exe
Skype.swe
Lightshot.exe

s make it 3 firefox.exe

Windows Optimization

1 RAM: 64%

Duplicate File Finder

mpact §

yau can alio

Clean Up

<.---.

@ Auslogics BoostSpeed 13

[ maintain 2, Aska Question

Unused Programs

Il appli

Force Uninstall

ﬁ All Tools

O Protect

Useful toals

<

¢ - % File View Toals Help ® Auslogics BoostSpeed 13
[2] pupiicate Fils Findar ' nner B Optimize [_Ti:[ Clean Up . 5} My Advisar G

ow will firsd

Traces in Web Browsers

ng h

Traces in Applications
Clean up les file data a of your online
and PC

Useful tools
Clean

and

ﬁf All Tooks

L —

[3 oupiicate Fite Finder

Bromss Pivavction




pommEEmERmmamEmmanEaeTt Maintain et seced it in s auir

' SETTEEEN
? SR

File View  Tools Help © Auslogics BoostSpeed 13 2 - X File View  Tools Help ® Auslogics BoostSpeed 13 € — X

/ Scanner g Optimize m Clean Up E‘ My Advisor O Protect .? Maintain 9\ Ask @ Question ? All Tools Ej Registry Cleaner > @ My Dashboard E My Scanner E‘ My Advisor ,Q.\ Ask a Question Tf All Tools D Disk Defrag > |+

@ Here you will find recommendations to help improve Windows components' stability, security and speed

) ¢ ) [ Tool Reports
Cat Mod -E bled - S |
Performance e — |n

You can view all reports on all operations, or just

To unlock: Hold Left Shift + Hold P :
reports for a specific time period for a selected tool.

Left Ctrl + Press W, Press S ;

= | [All Tools

St b|l| Shc etails Include ca
A ty What is Cat Mode Dat =

€ Disks (43 KBps) 150 MBps 5 4%
() Activate Sattirgs o3 Duplicate File Finder ~ 07.10.2022

Security Show details ) : | 5] Report Duplicate File Finder  04.10.2022
] Report 4 Deep Disk Cleaner 22.09.2022

Report ' Internet Optimizer 07.09.2022
Internet Show details €  Includ y [l Useful tools

Network (2 KBps) 1 MBps ] Report | Dashboard 29.08.2(
57 Report - Stability o) Dashboard 29082022
i Report - Disk Space ) Dashboard 20.08.2022

| Report - Performance (?) Dashboard 20.08.2022
Report ) Dashboard 29.08.2022
3 Report %) Dashboard 29.08.2022

2 running . .
Memory (56%)

You need to scan the system to get an updated list of tweak =i ] cmateﬂoostspeed Portable

suggestions. Categories you may have turned off will not be ! ﬁ-‘pawal;ﬁll toolkit that's always at hand Task Manager! # Create System Report i Delete Reparts |
included in the scan. = | | : !

8 HDD: 0% T2 NET: 19,9 Kbps RAM: 5 d O ¥
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Optimize

The Optimize tab gives you the tools and
options you need to ensure the most
efficient and productive Windows
operation.

In the first column, you can select drives
to defragment and click the button to
launch defragmentation. If using Windows
10 or 11, you can also run version-specific
optimization by clicking the Windows
10/11 Protector link here.

The second column gives you quick
access to task-specific modes you can
enable to boost your Windows for
whatever you are doing at the moment.
You can turn on Game Mode when you
want to play computer games, Office
Mode for working with documents and
productivity apps, Economy Mode to save
battery power, or a Custom Mode that you
set up yourself. Click the ‘See details &
customize’ tile to review and adjust mode
settings.

File View Tools Help © Auslogics BoostSpeed 13 = —

O Protect

* nner :‘_ Optimize m Clean Up E‘ My Advisor |:| Maintain ,Q\ Ask a Question ﬁ ~ All Tools B Duplicate File Finder *

@ Smart real-time performance menitoring and enhancements delivered when you most need them. Enable all tools for best effect and a higher overall boost.

Windows Optimization ® Processor ® Disk Priority Manager ® Desktop Protection ® Memory

Choose your preferred Windows mode
for optimal performance

Windows (C) Processor Optimization JEEIER|

This tool menitors the list of running processes and ensures optimal resource
allocation. This promotes the most effective processor usage and speeds up the
system and applications.

Normal Mode Economy Mode

CPU load: (6%)

Office Mode Custom Mode

Process name Application hame
Defragment selected drives to prevent Game Made See details &

freezes. customize explorer.exe

Integrator.exe
Skype.exe
Lightshot.exe
firefox.exe

Explorer 10.0.19041.1889
BoostSpeed 13.x

Skype 8.88

Lightshot 5.5.0.4

Firefox 105.0.1

Windows Optimization
you can also
Optimize your Windows to make it work
faster |:_'|I: Windows 10/11 App Cleanup

G_: Windows 10/11 Protector Dicable Pro r Optimization i

23 NET: 85,8 Kbps [l RAM: 64%

X

T oooooooon®®®qy

@
4

The third column lets you review current
resource statistics and enable real-time
speedup tools: Memory and Processor
Optimization, Auto Defrag, Disk Priority
Manager and Desktop Protection. Each of
these tools optimizes resource
consumption and ensures the best speed
for the applications that are active at the
moment. We recommend keeping these
tools enabled at all times to help things
run faster on your PC.

Right below the mode tiles, you will find
additional tools for optimizing your OS.
You can run additional Windows tune-up
using the Maintain Windows option, or
get rid of unneeded application add-ons
via the Windows 10/11 App Cleanup link.
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Clean up

The Clean Up tab gives you quick R Vet e e
LJ__IJ Clean Up

o :
¢ nner 52 Optimize

access to all BoostSpeed features
related to system cleanup. Let's take
a look at your options displayed on
this screen left to right:

In the first column, you can select

Data (D:)

71 GB free
341 GB

the drives youd like to clean, then _
choose the tool you want to use for ~ :
cleanup. Selected drives are
highlighted in green with the green
checkmark at the top-right.

you can also

The second column provides quick

i""|_| Remove unneeded large files

access to tools designed for cleaning

and tweaking your Windows registry
and system folder

P—

® Auslogics BoostSpeed 13

O Protect

E‘ My Advisor

Windows 10,
version 19044

Registry Cleanup

Clean out unused ies and maintain
your Wind gistry.

ii Clean registry entries
@ Compact Windows registry
you can also

188 Reduce Windows folder size

D Maintain

,Q\ Ask a Question

applications installed

Unused Programs

Uninstall applications that you don't use
anymore

Manage Installed Apps -

Force Uninstall

Remove applications that cannot be
uninstalled the regular way

IL [T, Delete broken apps
I

===,

T Al Tools

re
I
j. Find
- T
BT

e

F2 NET: 284 Kbps RAM: 63%

L - X

D Duplicate File Finder *

Manage installed
applications (&)

Free up even more space using the
third column: here you can uninstall
unused software, including apps that

are hard to remove or may leave files
behind.

The fourth column lists BoostSpeed
tools that can help clear disk space.
Most of these are already linked to
from the previous columns, but they
are still listed here for your
convenience.
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Protect

o’ %
] [}
: \%
o File View  Tools Help ® Auslogics BoostSpeed 13 o - X
The PI‘OteCt tab helps you secure personal ‘' nner %.: Optimize Iﬁ] Clean Up E‘ My Advisor :' Protect [:] Maintain ,Q\ Ask a Question ‘ti’ All Tools D Duplicate File Finder

data and activity history saved on your
computer. Traces of your credit card and other

financial info, passwords £\ Traces in Web Browsers scan requred gory [ 4%, Browser Protection
stored openly |n flles hIStOI’y of WebSIte VISItS .'I Keep your browsing habits private by getting rid of cookies ' Activate Browser Protect_ion if yl'DU'd like to
z 2 " o that follow your every step guard your browser against unintended
: : —_— changes
video views and other data you may want to — i "
] . i . (e i ‘ e B o 2 Ver. 105.0.1 51 Change Default Browser
keep private is actually quite easy to retrieve Traces in Applications  senrequied ‘
\l 4 Clean up logins, profile data and other traces of your online o Activete Browsar Protecticn
from your PG, if it ever gets in the wrong L andCactivity fortotal privcy
hands. We recommend running a scan for . Check your PC for threats
: . g f ‘. Adult Website Traces  scan required Include category [v] an:cvuyll:::abilii‘i:s wt;:: Auslogics
pl’lvacy traces and Cleanlng them Up on a ! || Even if you've never intentionnaly visited any adult sites, Anti-Malware
: 4§ there may still be traces on your PC Customize category €2

¥ See details and install

regular basis (from once a week to once a day,

depending on how heavily € )\ Traces in System Files  scan required _ v
| Clean up logins, profile data and other traces of your online
you use you r PC) & \ v ) and PC activity for total privacy : Customize category @

On the left side, you see the four areas

You need to scan the system to get an updated list of privacy traces.

that can be Checked for pr|vacy traces_ If : Categories you may have turned off will not be included in the scan.

youd like to have one or more of them N, =
._ e - Fa NET: 72,3 Kbps RAM: 63%

ignored during scans, just uncheck the : '

‘Include category’ box next to it to E

exclude it. E

Click the ‘Scan now’ button below the : :

category list to launch a quick scan for @:cccccccccccccccccccccccccccccccccccccccccccccces ~

privacy traces.

On the right, you get to control your web
browser and protect it from unauthorized
changes using the Browser Protection tool.
Just enable the tool by flipping the switch
here.

Right below this feature, you see some
recommended tools that help protect
your confidential files and guard your
Windows system from hackers.



When the scan completes, review the Fle  View  Tools  Help ® Auslogics BoostSpeed 13

@ My Dashboard B My Scanner Im Clean Up E‘ My Adlvisor %.: Optimize |:' Protect D Maintain

results by clicking the ‘Check Details’ link

next to each category, and remove all @ o _
Here you will find features that let you protect your system and clean up privacy traces

traces to protect your privacy. If needed,

you will be able to exclude some of the :
Traces in Web Browsers  Last scan:

detected items from the cleanup by Traces found: [ERYEY

Check Details @

M Firefox
Ver. 105.0.2

simply unchecking the boxes next to

them. Traces in Applications

Traces found: m

Check Details

Adult Website Traces Last scan: 07.1 :28
Traces found: n

When done, just click the ‘Resolve all
items’ button to get all of those privacy

traces removed and your personal data Chedceals ©@

protected. Traces in System Files  tast scan: 07.

Traces found: m

Useful tools

Check Details €

o Re =
il by
7N

¢

R Ask a Question Lif ~ All Tools

Browser Protection Jays|]

Activate Browser Protection if you'd like to
guard your browser against unintended
changes

&1 Change Default Browser
() Activate Browser Protection

Check your PC for threats
and vulnerabilities with Auslogics
Anti-Malware

¥ See details and install

Fa NET: 29,0 Kbps RAM: 53%

X

NOTE

The tools you see recommended
under the Clean Up, Optimize and
Protect tabs can also be found
under the All Tools tab: that's where
you can quickly access any tool you
need without having to look for it
under different tabs.
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Maintain

In addition to the more common optimization features we have looked at earlier in this Guide, BoostSpeed gives you even more control over your Windows system by checking

every corner of it for potential tweaks that could be applied to improve security, stability and speed.

© Auslogics BoostSpeed 13

O Protect

File View Tools Help

The Maintain tab lets you run a check for such
potential tweaks, review the suggestions and

E‘ My Advisor ﬁ Optimize

@ My Dashboard E My Scanner [ﬁ] Clean Up

Here you will find recommendations to help improve Windows components' stability, security and speed

apply any you want your PC to benefit from.

Performance Show details € Include category [+

BoostSpeed will look for tweaks under
Performance, Stability, Security and

Show details @ Include category [/]

: Stability
Internet categories. Once a scan
completes, you will most likely get a long

Show details € Include category [v/]

Security

list of personalized recommendations,

Show details £ ry Useful toals

Internet

which may include hardware tweaks or

other similar tweaks that need to be

applied manually, as well as a number of "
tweaks you can have BoostSpeed apply :
automatically on your behalf. Review each

tweak and uncheck any that you aren’t

sure about, then click the ‘Apply all

selected tweaks' button to have

You need to scan the system to get an updated list of tweak
suggestions, Categories you may have turned off will not be
included in the scan.

BoostSpeed go through the tweaks one by
one.

connection (3)

¢ — X

,Q\ Ask a Question ﬁ, All Tools

Cat Mode —Bisabhd

If you have a cat or another curious
pet, you can protect your keyboard
against its paws

What is Cat Mode? (video demo)

‘_ Activate

Settings

Optimize Internet

.'"é Cat Mode (see next page for info)

5 Right below Cat Mode, you get shortcuts

S
(]

*  to some useful system maintenance tools.

Cemo®®®®®®®®®®q

Further down is a feature that will come in
handy if you need to boost your other
computers without having to install
BoostSpeed on them. You can simply
create a portable version of BoostSpeed,

S
Ttococemeoooooooeoooooo,

save it on a flash drive and use on other
PCs in your household. This is especially

: useful when you want to run maintenance

* on a computer that is running out of disk

- space and has no room for installing other
software. Now you can get every PC in
your home to run great and help your
family enjoy their computers too. Keep in
mind that if you want to use BoostSpeed
Portable for commercial purposes, you will
need to purchase a license.



Cat Mode REiElIEG

To unlock: Hold Left Shift + Hold
Left Ctrl + Press W, Press S

What is Cat Mode? (video demo)

() Activate | Settings

Here is how the tool works.

Click on the ‘Settings’ link to set the time that should pass without any
activity on your PC, after which the mode gets enabled. You can also
choose whether you want your mouse buttons to be locked in addition to
the keyboard; choose the combination of keys that must be pressed to
turn the mode off and set other options. When done, click the ‘OK’
button.

Now, you can hit the ‘Activate’ switch whenever you are about to step away
+--@ from your PC, or have it active at all times, so it will get turned on once your
PC has been idle for the amount of time you specified.

@ nNoTE

Do you have any pets in your home who might like hanging out next to or on your desk? Then you
will love the Cat Mode feature designed to protect your computer from pet-caused accidents.
When active, the mode gets your keyboard (and your mouse, optionally) locked when you are away
from your PC, which lets your cat safely rest on your keyboard, play with your mouse or try to type
any messages without risking that you'll get upset at the result. The accidents this helps prevent can
be real disasters, as reported by many pet owners who have lost important data or lost access to
their computers because of something their pets did.

To disable the mode when you return to your PC, just 89.; -:.

click the combination of keys you have set for Cat Mode =
to require. If you have forgotten it, don't worry: your

Cat Mode Active

screen will show you a prompt whenever your PC gets

Auslogics BoostSpeed has just protected

locked by BoostSpeed. your computer from a cat attack.
To unlock and use your PC, please follow these instructions:
e ’ Y -
. Hold , Hold , Presstwice
TS A R Left Shift ~ LeftCtrl  Right Shift

If you set the idle time to 1 minute, you may see Cat Mode get enabled when you are reading a large article on screen or looking through some other info without touching your keyboard or mouse for
over a minute. However, setting it to 5 minutes or longer may result in your cat jumping on your PC’s keyboard before the mode gets a chance to protect it. A good solution would be to set the time to 1
minute, but have the mode enabled every time right before you step away from your PC instead of keeping it on all the time.
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Reports

When running maintenance or optimization
on your computer, it is important to be able to
see the results you are getting. The Reports
tab gives you just that, as well as lets you see
when maintenance may be needed.

On the left side of the screen you can
monitor current resource use statistics.

This provides a great overview of how your
system is handling all the tasks and :
applications that are currently running on :
it. If you see extremely high CPU, disk, :
network or memory loads, you will know :
that something might be wrong and will

be able to take action by using the Clean

Up and Optimize tabs.

File View Tools Help

m My Scanner

Q

F

@ My Dashboard E' My Advisor

Ask a Question >

® Auslogics BoostSpeed 13

@ Here you will find current system resource load charts and can view reports on all operations.

3 CPU (14%)

Detailed view

& Disks (43 KBps)

2 Network (2 KBps)

) Memary (56%)

150 MBps

1 MBps

———
| Pj Create System Report

YT ATools  [2] Disk Defrag >

Tool Reports

You can view all reports on all operations, or just

reports for a specific time period for a selected tool.

Mame

Report
| Report
| Report
Report

| Report

Report

@1 03 ©3 O3 07 O O3 O] ©7 O

Report

=3 NET: 19,9 Kbps

Report - Stability
Report - Disk Space

Repert - Performance

RAN

| [All Tools

Juplicate File Finder
Juplicate File Finder
Deep Disk Cleaner
nternet Optimizer

Dashboard

(%) Dashboard
=) Dashboard
) Dashboard
) Dashboard
) Dashboard

Date v
07.10.2022
04.10.2022
22.09.2022
07.09.2022
29.08.2022
29.08.2022

On the right side you see a table that lists
reports created after every operation. You
see the report name, the name of the tool
that created it and the date when the
operation ran. Filters above the table let
you search for specific reports by creation
time and tool name. Click on a report in
the table to select it, then click the ‘View
report’ button below the table to view it.
Use the ‘Delete’ button to delete all
reports ever created or just the reports
listed above (the ones that match your
search filters): you can select the option
you want from the drop-down menu that
opens when you click on the ‘Delete’
button arrow.
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Scheduling Maintenance: Automatic Defragmentation

BoostSpeed lets you schedule regular maintenance for hands-off cleanups and tune-ups. This helps keep your PC running fast and smooth for you continually.

RAM: 63%

To schedule tasks, click on the clock icon at
the bottom-right of the main program
window.

A window will open on the ‘Disk Defrag’
tab, where you can set up a schedule for
automatic defragmentation of your
computer drives.

o Deep Disk Cleaner

(® SCHEDULER

Scheduler: Disk Defrag

[v] Defragment automatically

How often?

Which drive?

Options:

Last Report:

When PC is idle * * 15 minute(s)

[¢/] Defragment all local disk drives, or select one or more disk drives:

v Windows (C:)

[¢] Do not aute-defrag when laptop is in battery power mode
[]5top defragmentation when a program launches in full screen mode

[#] Create report after defragmentation

Last scheduled defragmentation:

Defragmented:

& Cancel

Choose how often you would like to run
defragmentation and which drives youd like
BoostSpeed to defragment automatically.

You can also enable other options here to
prevent defrags from interfering with your PC
use. Set BoostSpeed to create a report after
every automatic defrag, if youd like. You will
be able to see brief statistics on previous
defrags right here below all options.
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Scheduling Maintenance: My Scanner

The ‘My Scanner’ option in scheduler Select the categories you want included in the regular scan and repair (you can click the arrow Now specify the time that's convenient for
settings lets you set up automatic scans next to category name and select specific subcategories only, if you like). - running maintenance. It's best to set a
for actionable items under Disk Space, time when your PC is usually on, but you

Stability, Performance, Disk Defrag, are not using it very heavily. Click OK

L]

; ------..
°

.

.

’

20)

Privacy, Internet Speed and Windows 10 E when done.
Tweaks — the functionality that you run 5 A
manually using the My Scanner tab in ®--. o Disk Defrag ' @ NOTE
BOOStSpeed'S main WindOW. Having ; E ) 31.‘: File Finder [+ Enable automatic maintenance & :
BoostSpeed run these tasks automatically E 5 cxr on — ' The My Scanner schedule includes
on a regular basis frees up your time and : - (A Disk Space [Daily ! options for running Disk Defrag and
helps ensure smooth PC performance ; B DISK DEFRAG sty Time Privacy scans, which can also be set up

' o (Cluster Mat = |20:00:00 d . .
without requiring you to do anything ' ey ] J separately from the respective tabs in
manually. : 2 . S the Scheduler’s left-side menu.

g ALGORITHM

: ¥ [m] Disk Defrag

RAM: 63% E [¢] Internet Speed
E (& SCHEDULER [¥]Windows 10/11 Tweaks
““--> ® My Scanner
@ 0o

. . @ LANGUAGE . K | ¢ cncel |
To schedule tasks, click on the clock icon at . =

the bottom-right of the main program
window.
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Scheduling Maintenance: Privacy

In addition to junk file cleanup and
performance optimization, you can have

BoostSpeed run regular cleanups of ®--.

privacy traces using the ‘Protect’ option in
scheduler settings.

RAM: 63%

To access privacy cleanup scheduling options,
click on the clock icon at the bottom-right of
the main program window.

OO D@D D@D DD DD DD DD DD DD DD DD DD DD DD D ® > > > »P
4

eduler Protect

[v] Enable automatic maintenance £

How often?

Privacy Daily

Protects your private data by erasing confidential records from )

your browsers, system components and applications Time:
20} o

[¢] Traces in Web Browsers 20:00:00

[#] Traces in Applications

[#] Adult Website Traces

[¢] Traces in System Files

Just like you did when scheduling My Scanner,
here you can click on the arrow next to the
word ‘Privacy’ to expand the list of
subcategories, and check or uncheck them as
needed. Then choose the frequency and
convenient time for your regular cleanups and
click OK when done.

Having traces of your private data, including
credit card and banking info, cleared from
various locations on your PC helps ensure that

this information will never get in the wrong
hands.
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Program Settings: General

Although BoostSpeed works great on default settings, it also offers extensive customization options, so you can enjoy a program that looks and works exactly as you want it.

Settings

RAM: 63%

o> @ cEnera

AN {
] : e Fi
: ..'.. . :
To access BoostSpeed Settings, click on the S © A
gear icon at the bottom-right of the main E F NOTIFICATI
program window. E @ IGNORELISTS
This will open the Settings window on the ‘ g ' Disk Defrag
e o Duplicate File Fir
General tab. ; .
) CAT MODE
B D A

General
[¥] Start automatically at Windows logon

[T1©n clicking the X, close program window, but keep backgraund optimization task

You will see a program icon in the system tray and will be able to fully clo

[¥] Don't ask for confirmation when closing tabs

[#]Shaw tray notifications when tasks complete

[¥] show informational tray notifications

[¥]Show Ads

["1Enable system-critical categories
-critical' may sometimes lead to system or soft

recon

[[] Delete cookies on every cleanup

d by clicking on it

ware malfunctions. This option is

Protects g y, but may clear active sessions and require you to re-enter login info on websites

& Cancel

Here you can set the program to launch on PC
startup to ensure that it monitors performance
and runs optimization in the background as
needed. You can also choose which
notifications BoostSpeed displays and switch
BoostSpeed scanners into advanced mode by
enabling system-critical categories here.

This is also where you tell BoostSpeed
whether you want browser cookies deleted on
every cleanup. Keep this box unchecked if you
want to keep the cookies and prevent various
sites from requiring you to re-log in every time
you visit them.
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Program Settings: View

The View menu lets you customize the program’s appearance.

RAM: 63%

To access the View settings, click the gear icon

at the bottom-right of the main program
window. Then select the ‘View’ tab from the
left-side pane.

There are 3 sub-sections under View,
which let you customize the program’s
general appearance, as well as the
appearance of the Duplicate File Finder
and File Recovery tools.
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Settings

View: General

Size of application interface text and elements:

something other than the recommended value, it may cause

Show temperature in degrees

Amount of consumed resources (%):

200% L4

application text and elements to be displayed incorrectly

Celsius (°C)

Computer screens may have different
resolution, and BoostSpeed allows adjusting
the size of interface text and elements to
better fit the resolution on your PC.

The other options in the General view settings
let you choose how CPU temperature should
be displayed and whether heavy resource
consumers should be marked in red.



In the View settings for Duplicate File

Settings View: Duplicate File Finder
Finder you can set whether and how you
. . ° Show file preview (default)
want to preview detected duplicates,and @®--, €3 GENERAL
. ' 1 1. . . . c C e Default preview section: Preview
if youd like to include hidden folders in the "
search_ E @ VIEW [1Don't preview video files
.\ [[1 Don't preview files larger than
‘--.> e Duplicate File Finder
,
e e []Search in hidden folders
©
3 N A
The View settings for File Recovery let you set
i View: File Recover .
Settings . whether removable drives and SSDs should
[show removeble drives . o be displayed and available to the tool. You can
@ GENERAL This option e ¢ > USB flash disk al HDD, etc) in the list of available drives.
2 also choose if you want to preview
@ ViEW [] Show SSD driv . . .
This opt {interna state Drives in the list of available drives. recoverable f|les and Wh|Ch f|les Should not be
Sene reviewed.
Ynlicata Eils Cindas Preview Panel P
Leed File R and appearance of the default Pre panel that A X
" > '.'.-_ . lle Recovery GTE. ..
- '
E Show file preview (default) :
E E NOTIFICATIONS Default preview section: Preview E
: [[1Don’t show video file previews :
: @ IGNORE LISTS [[1Don't show preview for files larger than :
: b cann :
' '
' '
' '
' '
' [
' '
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Program Settings: Integration

BoostSpeed lets you integrate some of its For instance, if you choose to integrate Disk

. . . i Integratio . .
features and options into various system Settings e Defrag into context menus, you will then be
: . _ A : se Disk Defrag as your default defragmentation program 2 _ A c o

LSl Thls allOWS you o rlght ClICk on ° @ GENERAL f ur | can replace Windows Defrag with Disk Defrag and use it as the default program for disk able to rlght ClICk el fOlder il Flle Explorer

items and run BoostSpeed operationson ~ @--, and defragment that folder. You can also set

them without having to actually open : : Vi Disk Defrag as your default defragmenter, add

BoostSpeed. Go to the ‘Integration’ tab to : the “Unlock File”, “Recover Files” and “Shred
(] o  Duplicat de

dO that : o Filo Retover [Tlintegrate Tweak Manager into the Desktop context menu Filesﬂ Options to drive and ReCYCle Bin menus.
" This adds Tweak Manager to your Desktop's right-click menu, so you could easily tweak it.

The integration is seamless, but is easy to

undo anytime you want.
@ IGNORE LIS
RAM: 63% o
Defr
uplicate File Fi
) CAT MODE
ind Duplicates' command to the Windows Explorer context menu

E:] DISK DEFRAG uplicate File Finder to the right-click menu for your disk drives and f o you can easily locate and remove file

o (Cluster M ap

To open Settings, click on the gear icon at the o SSD SuppoH Recommendation || select All || Unselect Al ' < [ e cance

bottom-right of the main program window.
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Program Settings: Notifications

When running tasks or monitoring
system status, BoostSpeed shows
notifications in your system tray
(bottom-right corner of your
computer screen).

You can disable notifications by
checking the ‘Don’t show this again’
box on the popup message, or do it
in the settings.

OO ®®®®®®®®® o

S INT

]

Settings

CRIED AL
EFNERA

Notifications

Perfarmance Monitor On

g system on and off. When monitoring Is disabled, the system tray will only show a basic popup, but no

Notification Window

(O Basic Info (@ Advanced Info

ifications, which show both basic and advanced parameters

Notifications
Show BoostSpeed Notifications
Show Privacy Notifications

Show Windows Motifications

[¥] Show Hardware Notifications

of Boc

ed operation, along with useful info on

The Notifications section in program
settings is where you can choose which
notifications you want to see in the tray.
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Program Settings: Ignore Lists

BoostSpeed'’s scanners and some
tools have Ignore Lists you can add
objects to when you want them
excluded from scans and cleanups.

When working with each of these
tools, you have the option to add
items to exclusions as you go.
However, you may find it convenient
to handle the Ignore Lists from the
program’s main Settings window, as
it lets you see all of the exclusions
you have set or can set.

e XU T RC R RTRC R R RC R R RC R RN RCRCRC R L d
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Settings

IGNORE LISTS

Scanners

Drive paths ignore list

This list contains files and folders to be skipped during scans. You can add items to this list from the detailed scan results window or
add them manually using this form.

Add Folder |

Path on hard drive

Registry ignore list

This list contains registry keys you would like to be skipped during scans, You can add keys to this list from the detailed scan results
window or add them manually using this form.

Registry key

& Cancel

Under Ignore Lists you see the sub-
sections for Scanners (the features you
use under the My Scanner tab in
BoostSpeed’s main window), Disk
Defrag, Duplicate File Finder and File

Recovery. Click through them and follow

the on-screen instructions to add or
remove items.
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Program Settings:

Additionally, BoostSpeed lets you
customize the way it handles files
and set additional options for various
tools and features.

You can have the program wipe junk
files being deleted to prevent their & ALGORITHM

recovery. You can also specify regular

® Disk Defrag

folders that you want cleared during
cleanups (just make sure none of
their contents are important, as they
will be permanently deleted).
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Some tools use algorithms that can

(]
0
)

be further customized and fine-

. XX

tuned to fit your individual needs:
just click the tool in the left-side
pane and make your selections.

Algorithm: Disk Defrag

[]skip fragments larger than

Reading file fragments takes much longer than head positionir

ragmentation go faster,

[[1Move system files to the beginning of the disk

Moving frequently accessed files to the faster part of the disk drive

Disk cleanup

o 1~ S TR

1g. This makes large file fragment defragmentation

will speed up disk access, but will increase defragmentation

ceived from the Prefetch system

red while defragmentation is unc

vay. This can speed up

e e @@
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Scroll down the left-side pane to see
the settings for Cat Mode and
Rescue Center (both covered earlier
in this Guide).

The last option is ‘Language’ which
lets you choose the interface
language for BoostSpeed.

When done adjusting settings, be
sure to click the OK button to apply
the changes.
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Contacting Auslogics

@ Auslogics BoostSpeed 13 G

Many of the questions you may have i R ook Sl Should you have any questions that

@ My Dashboard E My Scanner E' My Advisor "[? All Tools ﬁ JLEEERVEGELEIEIN = Ask a Question X Bd

regarding Auslogics products have
already been answered in the FAQ
section on

The Support section on the Auslogics
website also offers a way to retrieve
a lost license code, request a refund,
download product manuals and
more.

(@) &= L'f—_|

0

-
Hello, guest!

ﬂ free questions left

Sign in or sign up to continue
Sign Up

Reset password

Service terms E

Need help? () How to register

@ All features related to program technical suppaort

Ask a Question

Get professional answers here

Auslogics proudly presents a new unigue feature: a way for you
to directly contact our computer experts.

If you have any questions regarding Windows, PC, installed
software or devices, ask our experts and receive a comprehensive
answer.

Choose a question category:
Windows questions
Software questions
Device guestions

Having problems with Auslogics software?

Ask your guestion as many times as you need: it's always free.

@ How to uninstall

See these useful links: (D How to upgrade from previous version @ View user manual

Auslogics BoostSpeed

(version 13.x)

+ Program registered

Latest Questions

09.09.2022 The JBL connected with Bluetooth Properly
where in the sound output of windows 10 it does not
appear

Hello

| conntected with Bluetooth the device - Speaker JBL Flip 5
(bluetooth connection only). It appear in the the Setting /
bluetooth Devices of Windows 10

But in the settin... Read Now

0 > disk defrag

hi, uld like some help as disk defrag after
defragmentation sometimes shows me the screen as an
attachment instead of contiguous lines; | have a windows11
pro 64 bit pc and dis... Read Now

%5 NET: 29,9 Kbps RAM: 53%

£ Read other questions

are not answered on the website,
you can ask Auslogics experts using
the ‘Ask a Question’ tab in
BoostSpeed, or email our dedicated
customer support team 24/7 at

Our mailbox is monitored and emails
are answered 24/7, and we try to
respond to all inquiries within 24 to
48 hours.


http://www.auslogics.com
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Thank you for using
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